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SARscapeについて
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SARscapeとは

◼ENVIの追加モジュールであるSARscapeは、SARデータ処理機能をパッケージと
して設計されており、スイスのsarmap社によって開発されています。光学セン
サの可視化やデータ解析に定評のあるENVI上で動作し、GUIを提供しています。
最新のSARセンサの処理やSARデータと光学データを組み合わせて解析する際に、
非常に有効なツールとなります。

◼モジュール構成

– Basicモジュール

– Focusingモジュール

– Gamma & Gaussianモジュール

– Interferometry/Differential Interferometryモジュール

– Interferometry Stackingモジュール

– ScanSAR Interferometryモジュール

– Polarimetry/Polarimetry Interferometryモジュール
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SARについて
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SARデータとは

◼SARデータと光学データの相違点

4

光学衛星

（航空写真と同じ原理）

レーダ衛星

レーダ衛星の長所

1. 雲を透過して観測可能

2. 夜間も観測可能

短所

1. 電波を見るので判読しづらい

2. 1回の観測で白黒情報のみ

光学衛星の長所

1. 太陽光が地面で反射した光を観測し見やすい

2. 1回の観測で、色情報量が多い（RGB）

短所

1. 雲を透過して観測不可能

2. 夜間も観測不可能
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SARデータとは

◼レーダイメージングシステムの重要な特性は、光学センサと異なり、アクティブ
なセンサであるという点です。レーダシステムは信号を発信して地表から反射し
て戻ってきた信号を記録します。システムそのものは、電磁気のエネルギーを発
生させています。レーダシステムはアクティブであるため、太陽を光源とせず、
昼、夜を問わず観測を行うことができます。

◼SARの特徴

–夜間観測可能

– 雲を透過する

– 白黒画像

– 表面粗度を観測

– 水面を分離しやすい

–振幅と位相の情報を持つ

– 偏波が使える
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SARの用語

◼以下の図に示した用語はSARデータを処理する上で、必要な用語となり、本マ
ニュアル内でも使用します。
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演習に入る前に

ENVIの起動方法やUIについて説明します
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ENVI/SARscapeインターフェース
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ENVIの起動方法

Windows10 

[Start Menu] > ENVI 5.6 > ENVI 5.6 (64-bit)

Mac

/Applications/harris/ -> ENVI5.6のアイコンを選択

Linux

ターミナルから envi_rtコマンドを入力する
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ENVIインターフェースについて

メニューバー
ツールバー

レイヤマネージャ

カーソル値表示 プロセスバー

ツールボックス
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ENVIインターフェース:メニューバー

ファイルを開く、編集、表示に関するツールや、ウィンドウの分割など、
インターフェース及び、画像の基本的な操作に必要な機能を提供します。
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ENVIインターフェース:ツールバー

ズームイン・アウトや、パン、アノテーション、ストレッチなど、表示した画像
に対して操作に関するツールをグラフィカルなアイコンで提供します（詳細は後
述します）。
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ENVIインターフェース:レイヤマネージャ

◼ インターフェースに表示されている画像の管理を行います。
◼ チェックボックスをオン/オフする事で、表示/非表示の設定を行います。

◼ ファイル名上で右クリックをすると、サブメニューが表示され、表示の削除
やRGBコンポジットの変更などが行えます。

13



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

ENVIインターフェース: オーバービュー

◼ レイヤーマネージャの[Overview]へチェックを入れることで、画像全体を表示
します。
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ENVIインターフェース:ツールボックス

◼ ENVI の解析機能がカテゴリごとに格納されています。検索機能が提供されて
おり、「Search the Toolbox」へキーワードを入力することで、該当の機能
がリスト表示されます。

◼ SARscapeの全ての機能もToolboxにメニューがあります。
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ENVIインターフェース:
カーソル値表示およびプロセスバー

◼ 地図投影法を保持した画像上でマウスを移動させると、カーソルのある場所
のピクセルに対応した地図情報が表示されます。

◼ プロセスバーは、処理の経過を表示しています。右側にあるバツマークをク
リックすると、処理はキャンセルされます。

16



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

ENVI HELPとSARscape HELP

指定のブラウザを使用して、

HELP機能が起動します。
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◼ ENVI HELP
メニューバーのHelpから起動します。

◼ SARscape HELP
ENVIのToolbox内の

SARscapeのメニューか
らHelpを起動します。
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ENVI/SARscapeの基本設定について
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環境の設定: ENVIのPreference

◼ 使用するデータへのアクセスなどを容易に行うため、環境の設定を行います。
◼ ENVI では、ファイルの入出力ディレクトリをあらかじめ指定することで、
デフォルトで指定したディレクトリを表示することが可能です。
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環境の設定: ENVIのPreference

名称 機能

Input Directory 入力ファイルを指定する際に表示するインプットディレクト
リの指定

Output Directory 出力ファイルを指定する際に表示するインプットディレクト
リの指定

Temporary Directory 処理中に作成される、テンポラリファイルの保存先

https://www.harrisgeospatial.com/docs/Preferences.html#Director
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※SARscapeは、ワークフロー処理で生成される中間処理画像ファイルを、Preferences で指定したTemp Directory 内にSARsTmpDir***という

作業フォルダを作成して格納します。ワークフローの最後でこれらの中間ファイルを削除するか選択することができます。

削除しない場合は、上記作業フォルダはOutput Directory 内にwf_temp_***というフォルダ名に変更の上保存されます。

https://www.harrisgeospatial.com/docs/Preferences.html#Director


L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

環境の設定: SARscapeのPreference

◼ SARscapeの処理で使用される設定は、SARscapeのPreferencesで行います。
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環境の設定: SARscapeのPreferences common

◼ DEMなどのデフォルト読込先ディレクトリやGPUの使用設定を行うメニューです。
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環境の設定: SARscapeのPreferences specific

◼ 各処理に使用されるパラメータのデフォルト値を設定します。
◼ Load Preferencesボタンから、使用するSAR画像の特性にあわせたパラメー
タのデフォルト値に変更します。

◼ Sentinel-1のTOPSAR(IW)を使用した解析を行う場合には、Sentinel 

TOPSARという設定に変更しておくことが推奨されます。
◼ ALOSの高分解モードで撮影されたデータなど分解能10m以下のものについ
ては、<VHR (better than 10m)> 選択してください。
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ENVIの基本操作について
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ファイル読み込み

◼ ENVI にALOS PALSAR のSLC画像を読み込んで表示します。ラスタデータ
の読み込み、表示を行います。

◼ SARscapeを用いてインポート済みのSLCデータです。このデータはENVI形
式のデータです。

20091204_slc
25
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20091204_slcについて

◼ 読み込んで表示しているデータは、SLC（Single Look Complex）データです。
データのタイプは複素数（実数、虚数）となります。ENVIでは、内部的に
Magnitude（実数と虚数の二乗の和の平方根にしたもの）を計算した画像を表
示しています。
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ENVIのファイルフォーマットとは

◼ ENVI フォーマット(ENVI から作成されるファイル)は、単純なラスタフォー
マットのデータです。

⚫ このフォーマットはバイト型で形成され、フラットバイナリファイルと
呼ばれるデータフォーマットです。

⚫ このフォーマットは画像以外のデータが含まれないため、ENVI はENVI 

ヘッダファイル（ENVI Header File：*.hdr）というASCII ファイルを作
成し、そこに画像を読み込むためのパラメータ情報を記録します。

フラットバイナリデータ

ASCII ファイル

• 拡張子無しまたは.dat形式のフラットバイナリデータ
• .hdr形式の関連情報を書き込んだASCIIファイル

【ENVIフォーマットの構成要素】

27



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

ファイルの種類 内容

画像データ フラットバイナリの画像データ

ENVIヘッダーファイル ENVIがファイルを読み込む際に必要とするヘッダーファイ
ル（ASCII形式）

SARscape

パラメータファイル
SARscapeが処理の際に使用するパラメータファイル（XML

形式）

◼ SARscapeのファイルフォーマットは、データをSARscapeへインポート後に
作成されます。画像についてはENVIフォーマットと同等になります。ただし、
SARの解析を行うため、通常のENVIフォーマットに軌道情報等のSARの処理
に必要なパラメータが含まれたSMLファイルが付加されています。SARscape

でSARの解析処理を行うためには、以下の3つのファイルが必要となります。

SARscapeのファイルフォーマットとは

28

【例】
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ディスプレイツール

◼ ツールバーで提供されているツールを使用して、表示した画像に様々な操作
を行うことができます。

https://www.harrisgeospatial.com/docs/DisplayTools.html

Display Tools
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各アイコンについては
この資料の最後に補足としてまとめてあります。

https://www.harrisgeospatial.com/docs/DisplayTools.html
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補足:パン機能とズーム機能について

クリック

前後回転

30

※使用例の画像については光学画像を使用しています
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補足: 現在表示されているデータは、地理情報が登録されておりませんので、表示されている座標は画像のピクセル座標
になります。

ディスプレイツール: 演習
データ値の参照

◼ 表示した画像のデータ値を確認します。
1. ディスプレイツールの ボタンをクリックしてください。
2. Cursor Value のダイアログが表示され、マウスカーソル上のピクセルの情報
が対話的に表示されます。(十字の中心にあたるピクセル値)
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ストレッチの調整

◼ 表示した画像に対して、ストレッチやコントラストなどを変更して、画像を
見やすくします。

◼ データを読み込んだ際にRGB コンポジットで表示されている画像があるので、
その画像を使用して操作を行います。

32



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

ストレッチとは？

各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

33

各ピクセルには様々な値が入っており、上に示すような分布だとします。
（値の取る範囲はデータ型に依り、例えばUint型なら、0から65535の間の範囲です）

0 65535

※使用例の画像については光学画像を使用しています
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ストレッチとは？

各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

34

まずはENVIで表示するにあたって、データ値を輝度値(0から255のBYTE値)に変換します

※使用例の画像については光学画像を使用しています
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ストレッチとは？

各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

35

※使用例の画像については光学画像を使用しています

全体的に暗いので、
この辺りで見え方を
調整し直したい
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ストレッチとは？

各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

この辺りで見え方を
調整し直したい

36

この範囲で明るさを
再度調整した

※使用例の画像については光学画像を使用しています
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ストレッチとは？

各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

37

※使用例の画像については光学画像を使用しています
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ストレッチとは？

各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える
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※使用例の画像については光学画像を使用しています
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ストレッチの実施

◼ ENVI では画像を表示する際に、データタイプに合わせてストレッチの手法が
自動的に選択されます。今回のデータを読み込むと、Linear 2% のストレッチ
がかかります。

⚫ データ値のヒストグラムなどを見ながら、閾値などの調節が必要な場合
には、Histogram Stretchを使用してください。

◼ SARscapeの画像を扱う場合は、Square Root というストレッチの手法を選択
していただければ、輝度調整がうまくいく場合が多いです。

Linear 2% Square Root
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ストレッチの実施: 演習

1. ストレッチを へと変更します
2. ボタンで画像全体を表示し、 ボタンで水域(暗い箇所)を拡大します
3. ボタンで、表示したエリアについてストレッチを適用します
4. ボタンをクリックして拡大/縮小による自動更新を有効に設定します
5. ボタンで、全体に対して再度ストレッチを実施します

40

Stretch on View Extent



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

カラーの変更

◼ 前の項目で表示したレーダ画像に対して疑似カラーを付与します。

⚫ グレイスケールの画像には、カラーテーブルを割り当てることで、デー
タの分布を一目で確認することが可能です。

⚫ 疑似カラーを付与する機能として、「Change Color Table」と「Raster 

Color Slices」のツールがあります。
⚫ 本実習では、「Change Color Table」を使用し、グレイスケールの画像へ
疑似カラーを付与します。

Raster Color Slicesについては以下を参照: 

https://www.harrisgeospatial.com/docs/ColorSlices.html

41

https://www.harrisgeospatial.com/docs/ColorSlices.html
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カラーの変更：演習

1. レイヤーマネージャ→ グレイスケール画像の「20091204_slc」を右ク
リック→ Change Color Table →Rainbow を選択します。

2. カラーテーブルを選択すると、選択したカラーテーブルにより色づけされ
た画像がディスプレイに表示されます。
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カラーの変更：演習

3. カラーテーブルの色合いなどを確認したい場合は、レイヤーマネージャ→ 

グレイスケールの「 20091204_slc 」を右クリック→ Change Color Table 

→ More を選択します。

4. Edit Color Table によって他のカラーテーブルを選択することができます。

このウィンドウではオリジナルのカラー分布の作成、保存および読込も可
能です。

5. プルダウンメニューから「Rainbow」を選択して、元の状態に戻してくだ
さい。
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Change Color Tableの注意点

適用している疑似カラーは、データの実際の各ピクセル値に対してではなく、
ストレッチされた後の見え方に対して適用されています。

一方で、Raster Color Sliceはデータの実際の各ピクセル値に対して疑似カラー
を適用するので、ストレッチの影響を受けません。
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データマネージャ

◼ Data Manager は読み込んだファイルを管理しています。
⚫ レイヤーマネージャでは、表示している画像の情報しか表示されません。

⚫ データの詳細情報を確認する時や、すでに読み込んだデータを別の表現
(バンドのグレイスケール表示や、RGB コンポジットの変更など)で表示
する際にこのマネージャを使用します。
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データマネージャ：演習

1. メニュー→ File → Data Manager を選択してください。
2. Data Manager ダイアログ→ 「20091204_slc」の[Real]を右クリック → 

Load Grayscale を選択してください。
3. Real(実数) が表示され、レイヤーマネージャへ追加されていることを確認し
てください。

4. ツールバー→ Transparency で透過度を変更し、下のレイヤを透
過させてください。

46



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

Data Type

◼ Data Manager のFile Information の中で、「Data Type」という項目あります。

◼ 現在読み込まれているデータが、実数（浮動小数点）、符号付もしくは符合
無しの整数型かどうかを理解するのも、データ解析をする上で重要になりま
す。

詳細(data typeの項目を参照):
https://www.harrisgeospatial.com/docs/ENVIHeaderFiles.html#The

47
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画像を閉じる

◼ 表示している画像を閉じ、必要がなくなったView を閉じることが出来ます。
⚫ 個々のレイヤはレイヤを右クリックし、Removeで閉じます
⚫ Viewを削除する場合はViewを右クリックし、Remove Viewを選択します
⚫ Viewは残したまま、Viewにあるレイヤを削除するには Remove All Layersを選択します。

✓ Layer Managerから削除してもData

Managerにはデータが残ります。
✓ 必要のないファイルを閉じる場合は、Data 

Manager から該当ファイルを右クリック
→ Close File を選択してください。

48
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SARscapeでの基本処理（Basic Module）
データのインポートと切り出し編

49
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SARscapeでの基本処理（事前準備）

50

◼ ワークフロー内にもインポートや切り出しの機能はありますが、基本となるス
テップのため、それぞれの機能について説明します。

⚫ データのインポート
⚫ 解析範囲の切り出し
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データのインポート: 演習

51

◼ データ配布元から提供されたデータは、一度SARscapeのインポート機能にて
ENVIフォーマット＋SMLファイルの形式に変換する必要があります。

◼ SARscapeでは、これまでに衛星に搭載されているSARデータに関しては、ほ
とんどのデータをサポートしています。Basic モジュールを利用してSAR画像
を扱う上で必ず必要になるデータ処理方法について説明します。

1. ENVIツールボックス→ SARscape → Import Data → SAR Spaceborne  → 

Single Sensor → ALOS PALSAR-1 を選択してください。
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データのインポート: 演習

52

2. Import ALOS PALSAR-1ダイアログが表示されます。Input File List → Browse 

Files…ボタン をクリックしてCEOSのイメージファイル「IMG-HH-

ALPSRP205672900-H1.1__D」を選択します。

3. 今回のデータは、JAXAフォーマットのPALSAR FBS L1.1 のデータです。
Parametersタブ→ Data Type およびRename the File Using Parameters を変
更します。

【設定値】
C:¥Training¥SARscape¥PALSAR¥Original¥l1data¥

【設定値】
Data Type: JAXA – FBS Level1.1

Rename the File Using Parameters: false
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5. インポートしたデータは自動的にENVIへ表示されます。
6. KMLファイル（Google Earth 形式のファイル）も作成されますので、地理的
な位置を簡単に確認することが可能です。

データのインポート: 演習

53

4. Output Filesタブにて出力ファイル名を入力します。Output File List → ファイ
ル名を右クリックしてEdit → 「palsar_fbs_full」へと変更→ 「Exec」をク
リックしてください。

補足:メニュー→ File → Open As → Radar からもさまざまなSARデータをインポートすることが可能ですが、このメ
ニューから読み込まれたENVIフォーマットでは、SARscapeにて処理を行うことができません（ENVIで表示は可能）。
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ENVIのレンジ・アジマス設定
(※右側照射を前提とした説明)

54

【仕様】

ENVIは左上を原点とします。

– X軸方向がレンジ

– Y軸方向がアジマス

衛星の軌道は2通り

• アセンディング軌道

(南から北に向かう軌道)

• ディセンディング軌道

(北から南に向かう軌道)

どちらで撮られたかで
ENVIで読み込んだ際の
表示のされ方が異なる
※ジオコーディング前
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アセンディング軌道の場合

55

アセンディング軌道は
上下反転して表示されます
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ディセンディング軌道の場合

56

ディセンディング軌道は
左右反転して表示されます
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レンジとアジマスで分解能が違うため

なぜ縦に長くなっている？

57

例：ある衛星では、レンジ方向で2m解像度、アジマス方向で1m解像度とします。
この状態で10m四方を見ると、レンジ方向で5ピクセル、アジマス方向で10ピク

セル分データが取得できることになります。

10mを５ピクセルに分割

10

m

を
10

ピ
ク
セ
ル
に
分
割

表示する時は
各ピクセルは正方形

データを多くとれる（解像度の細かい）
アジマス側に伸びている

補足 : 必ずしも縦長とは限らない
• ENVISATは横長
• TerraSARはほぼ1:1



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

解析範囲の切り出し: 演習

58

◼ SARデータのSLC（Single Look Complex）はファイルサイズが大きいため、

フルシーンでは処理時間がかかってしまうことがあります。その際は、事前に
画像切り出しを施すことが有効ですが、SARscapeで切り出し画像を処理する
際にもsmlファイルが不可欠になります。

◼ ENVIや他のソフトウェアで切り出しを実施したファイルでは、smlファイルが
付属しておらずSARscapeでは処理できませんので、SARscapeのSample 

Selectionツールを使用して実施します。

1. ENVIツールボックス→ SARscape → General Tools → Sample Selections  → 

Sample Selection SAR Geometry Dataを選択してください。
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解析範囲の切り出し: 演習

59

2. Input Filesタブで入力ファイルを指定します。Input File List →Browse Filesボ
タン→「palsar_fbs_full_slc」を指定します。

3. Optional Filesタブを選択し、Area of Interestに切り出し範囲を指定したシェー
プファイルを指定します。

【設定値】
C:¥Training¥SARscape¥Output¥

<先ほど出力したファイル>

【設定値】
C:¥training¥SARscape¥PALSAR¥Shape¥

subsetArea.shp

✓ Sample Selectionで使用できるシェープファイルは緯度経度座標(Lat/Lon)で定義されている必要があります。
✓ UTMで定義されたシェープファイルでは切り出せないので注意が必要です。
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解析範囲の切り出し: 演習

60

4. ParametersタブのGeographic RegionをTrueに設定します。各Column/Rowの
値は設定したシェープファイルから読み込まれるので-9999のままで構いませ
ん。

5. Output Filesタブで出力ファイルを指定します。Output File List → 

「palsar_fbs_full_cut_slc」になっていることを確認し「Exec」をクリック
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解析範囲の切り出し: 演習

61

6. 結果が表示されることを確認します。

なぜ斜めに切り出されたのか？
出力結果

使用したシェープファイルのエリア
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解析範囲の切り出し: 解説

62

◼ 切り出しに使用したシェープファイルが長方形のポリゴンだとしても、頂点に
対応する緯度経度はSARイメージの上では必ずしも長方形にはなりません

◼ ジオコーディングという処理を実施した後に得られるイメージは、切り出
しに使用したシェープファイルと同じような長方形のものになります。
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SARscapeでの基本処理（Basic Module）
Sentinel-1を使用した災害の前後比較

63
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◼ インポート/サブセット済みのSentinel-1のSLCデータ2シーンに対して以下の
処理を行い、前後比較を行います

1. 強度画像の作成(Multilooking)

2. 作成した強度画像の位置合わせ(Coregistration)

3. 地図情報の付加(Geocoding and Radiometric Calibration)

4. RGB合成を変更することにより被害エリアを強調

処理の概要とデータについて

64
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使用するデータについて

65

◼ 関東地方における令和元年の台風19号襲来前後
⚫ 撮影時期: 2019年8月19日 / 2019年10月12日のペア(襲来は10月12日夜間)

✓ S1B_IW_SLC__1SDV_20191012T204247_20191012T204314_018447_022C0C_0256

✓ S1A_IW_SLC__1SDV_20190819T204321_20190819T204349_028643_033DB5_082A

⚫ パラメータ設定はENVI ツールボックス→ SARscape → Preferences → 

Preferences specific → Sentinel TOPSARを使用

出展: 東京消防庁
(https://www.tfd.metro.tokyo.lg.jp/camp/2020/202

005/camp1.html)

令和元年東日本台風に伴う増水した荒川
（国土交通省荒川下流河川事務所より引用）

https://www.tfd.metro.tokyo.lg.jp/camp/2020/202005/camp1.html
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Preferences specificの変更

◼ Sentinel-1のTOPSAR(IW)を使用した解析を行う場合ので、Sentinel 

TOPSAR (IW - EW)という設定に変更してください。
◼ /SARscape/Preferences/Preferences specific

66
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Sentinel-1のインポート結果について

◼ Sentinel-1は、広域を TOPSAR というモードで観測を行うため、ファイル
がバーストという単位で構成されます。
◼ 3つのサブスワスの中に約9個ずつのバーストが含まれており、

SARscapeにおいて、ユーザはこれらのファイル構成を意識することな
く操作できます。

https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-

sar/acquisition-modes/interferometric-wide-swath

67

https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/acquisition-modes/interferometric-wide-swath
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Sentinel-1のインポート結果について

◼ Sentinel-1は、広域を TOPSAR というモードで観測を行うため、ファイル
がバーストという単位で構成されます。
◼ 「*_slc_list」というファイルにおいてバーストが内部的に管理されてい

ます。各バーストのファイルは、出力に指定したサブフォルダ内に保存
されています。

各バーストの実体となる_slcは
このフォルダ中で管理

バーストの構成管理は
*_slc_listで定義

68
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Sentinel-1のインポート結果の切り出しについて

◼ Sample SelectionでSentinel-1のデータを切り出す際には、*_slc_listをイン
プットに指定する

◼ 出力結果は*_cut_slc_listで構成管理され、実体となる_slcは*.split_burst_cut

フォルダ配下に配置される

各バーストの切り出された実体となる_slcは
このフォルダ中で管理

切り出したバーストの構成管理は
*_cut_slc_listで定義

69



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

Multilooking

70

◼ マルチルック処理を実施する目的は次の3つです。
⚫ 強度画像を作成するため
⚫ SAR画像に含まれたノイズを軽減するため
⚫ (補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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Multilooking

71

◼ マルチルック処理を実施する目的は次の3つです。
⚫ 強度画像を作成するため
⚫ SAR画像に含まれたノイズを軽減するため
⚫ (補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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Multilooking

72

◼ マルチルック処理を実施する目的は次の3つです。
⚫ 強度画像を作成するため
⚫ SAR画像に含まれたノイズを軽減するため
⚫ (補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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Multilooking

73

◼ マルチルック処理を実施する目的は次の3つです。
⚫ 強度画像を作成するため
⚫ SAR画像に含まれたノイズを軽減するため
⚫ (補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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Multilooking

74

◼ マルチルック処理を実施する目的は次の3つです。
⚫ 強度画像を作成するため
⚫ SAR画像に含まれたノイズを軽減するため
⚫ (補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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Multilooking

75

◼ マルチルック処理を実施する目的は次の3つです。
⚫ 強度画像を作成するため
⚫ SAR画像に含まれたノイズを軽減するため
⚫ (補助的) 縦横をサイズを正方形に近づけ、地物の判読をしやすくするため
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Multilooking

76

1. /SARscape/Basic/Intensity Processing/Multilookingを起動します
2. 以下の設定を行い、Execを押下します

【Input Files】
C:¥training¥SARscape¥Sentinel

✓ sentinel1_46_20191012_204249184_IW

_D_VV_cut_slc_list

✓ sentinel1_46_20190819_204323662_IW

_D_VV_cut_slc_list

【Parameters】
デフォルトの設定とします

【Output Files】
C:¥training¥SARscape¥Outputに出力され
ることを確認する
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Multilooking

77

3. 強度画像が表示されることを確認します
• この時点では地図情報は設定されていません

Multilookされたデータ 対応するエリア

※斜め方向に切り出されているのは、Sample Selectionのスライドで説明したものと同様の理由です
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Coregistraion

78

◼ コレジストレーション処理では、スラントレンジ画像のまま画像のマッチング
を行うことが可能です。

◼ コレジストレーション処理を行うためには、各シーンは軌道と撮影モードが同
じである必要があります。

◼ DEMを参考情報として設定することもできます。
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Coregistraion

79

1. /SARscape/Basic/Intensity Processing/Coregistrationを起動します
2. 以下の設定を行い、Execを押下します

【Input File list】
C:¥training¥SARscape¥Output

✓ sentinel1_46_20191012_204249184_IW

_D_VV_cut_slc_pwr

✓ sentinel1_46_20190819_204323662_IW

_D_VV_cut_slc_pwr

【Parameters】
デフォルトの設定とします

【Output Files】
C:¥training¥SARscape¥Outputに出力され
ることを確認する
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Geocoding and Radiometric Calibration

80

◼ SAR画像では地上からのレーダ反射を斜め上空から測定しているため、高い
地物などでは、光学画像よりも大きなゆがみが発生します。
⚫ SARscapeではこのゆがみを補正するため、DEMを使用してジオコーディ
ング処理を行います。

⚫ DEMを使用し、フォーショートニング、レイオーバーといったSAR特有
のゆがみも補正することが可能です。

衛星側に倒れ込むように見える
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Geocoding and Radiometric Calibration

81

1. /SARscape/Basic/Intensity Processing/Geocoding/Geocoding and Radiometric 

Calibrationを起動します
2. 以下の設定を行い、Execを押下します

【Input Files : 先ほどの出力結果】
C:¥training¥SARscape¥Output¥

✓ sentinel1_46_20191012_204249184_IW

_D_VV_cut_slc_pwr_rsp

✓ sentinel1_46_20190819_204323662_IW

_D_VV_cut_slc_pwr_rsp

【DEM/Cartographic System】
C:¥training¥SARscape¥Sentinel¥DEM

- Srtm-3_V4_dem

【Output Files】
C:¥training¥SARscape¥Outputに出力され
ることを確認する
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補足: Grid Size

82

✓ マルチルックを実行するときのGrid Sizeと、ジオコーディングする際のGrid

Sizeは区別して考える必要があります
✓ マルチルックで指定するGrid Sizeは、元々のレンジ/アジマス方向の解像
度から1ピクセルの縦横サイズの目安を決めています

✓ ジオコーディングで指定するGrid Sizeは、出力されるデータの1ピクセル
を何m解像度と定義するかを決めています

レンジ解像度7m、
アジマス解像度3mとすると、
グリッドサイズ15mなら
レンジ2つとアジマス5つで
マルチルックする

7m 7m

3m

3m

マルチルック後
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補足: Grid Size

83

✓ マルチルックを実行するときのGrid Sizeと、ジオコーディングする際のGrid

Sizeは区別して考える必要があります
✓ マルチルックで指定するGrid Sizeは、元々のレンジ/アジマス方向の解像
度から1ピクセルの縦横サイズの目安を決めています

✓ ジオコーディングで指定するGrid Sizeは、出力されるデータの1ピクセル
を何m解像度と定義するかを決めています

マルチルックでグリッドサイ
ズ15mとしていても、
ジオコーディングした後の
1ピクセル解像度は
自由に定義できる

15m 15m

15m

15m

① ②

③ ④

① ① ①

① ① ①

① ① ①

5m 5m 5m

② ② ②

② ② ②

② ② ②

③ ③ ③

③ ③ ③

③ ③ ③

④ ④ ④

④ ④ ④

④ ④ ④

マルチルック後

ジオコーディングで
定義したのが5mグリッドなら
右図のようになる

※ジオコーディングの過程でリ
サンプリングの影響を受けるた
め、対応する座標のピクセル値
が必ずしも元と同じ値にはなる
とは限らない
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補足: Grid Size

84

✓ マルチルックを実行するときのGrid Sizeと、ジオコーディングする際のGrid

Sizeは区別して考える必要があります
✓ マルチルックで指定するGrid Sizeは、元々のレンジ/アジマス方向の解像
度から1ピクセルの縦横サイズの目安を決めています

✓ ジオコーディングで指定するGrid Sizeは、出力されるデータの1ピクセル
を何m解像度と定義するかを決めています

マルチルックでグリッドサイ
ズ15mとしていても、
ジオコーディングした後の
1ピクセル解像度は
自由に定義できる

15m 15m

15m

15m

① ②

③ ④

30m 30m

①から④を参考に計算された値

ジオコーディングで
定義したのが30mグリッドなら
右図のようになる

マルチルック後

※ジオコーディングの過程でリ
サンプリングの影響を受けるた
め、対応する座標のピクセル値
が必ずしも元と同じ値にはなる
とは限らない
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Geocoding and Radiometric Calibration
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3. ENVIレイヤマネージャに以下のファイルが追加されていることを確認します
✓ sentinel1_46_20191012_204249184_IW_D_VV_cut_slc_pwr_geo_meta

4. データマネージャーを起動します
5. 以下のRGB構成でロードします

Red:台風通過前(8/19)

Green: 台風通過後(10/12)

Blue:台風通過後(10/12)
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結果の確認
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結果の確認
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国土地理院:令和元年東日本台風に関する情報
https://www.gsi.go.jp/BOUSAI/R1.taihuu19gou.html

https://www.gsi.go.jp/BOUSAI/R1.taihuu19gou.html
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参考: 
Intensity Time Series による植生の時系列変化

88

◼ 複数の強度画像から特徴的なエリアを抽出・強調するためのワークフロー

変動係数(Coefficient of 
Variation)

最⼩値(Min)

勾配(Gradient)
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参考: 
Intensity Time Series による植生の時系列変化
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参考: 
Intensity Time Series による植生の時系列変化
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SARscapeでの基本処理についての補足: 
DEMダウンロードツール

91

◼ DEMダウンロードツール
DEMダウンロードツールはワークフロー内にもありますが、個別ツールもあ
ります。
⚫ ENVIツールボックス→ SARscape → General Tools→ DEM Extraction → 

使用するDEMを選択
⚫ ワークフロー内では、以下のInputステップのDEM/Cartographic Systemタ
ブが該当します。



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

SARscapeでの基本処理についての補足: 
DEMインポート

92

◼ DEMダウンロードツール以外で取得したDEMについて
Digital Elevation Model ExtractionツールでサポートされていないDEMデータ
をSARscapeで使用する場合は、SARscapeへインポートし、楕円体高へと変
換することで、SARscapeの処理で使用することが可能となります。
⚫ SARscapeへのデータのインポート
⚫ 楕円体高への変換

◼ SARscapeへのデータのインポート
1. ENVIツールボックス→ SARscape → Import Dataメニュー内の「ENVI 

Format」もしくは「Generic Format」→「Tiff」から手元のDEMデータに合っ
たフォーマットのインポータを選択してください。

2. データを読み込む際に、Parametersタブ→ Principal Parameters → Data unit

をGeoidal DEMに設定してください。Dummy Valueには、入力ファイルの無
効値を入力してください。
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SARscapeでの基本処理についての補足: 
DEMインポート

93

◼ 楕円体高への変換
1. ENVIツールボックス→ SARscape → General Tools → Cartographic 

Transformation → Geoid Component

2. Parametersタブ→ Principal Parameters → Geoid Operation → Subtract 

Geoidに設定し、Geoid Typeを選択してください。
3. Output Filesタブで設定する出力ファイルでは、「ファイル名_dem」となるよ
うに命名してください。
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SARscapeインターフェロメトリ
（Interferometry Module）

94
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SARインターフェロメトリ(干渉SAR)とは:
ヤングの干渉実験

95

◼ 光波と光波がぶつかって、強め合った箇所は明るくなり、弱め合った箇所は暗
くなります。スクリーン上にはそれらが交互に現れ、干渉縞という縞模様がで
きます。(高校物理 // 光と波のはなし)

◼ SAR衛星もマイクロ波を照射しているので、2シーンを干渉処理させると縞模
様ができます。干渉SARはこれと同じ原理です。



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

SARインターフェロメトリ(干渉SAR)とは: 
干渉処理を行う際の前提条件

◼ 処理で必須になるのは以下のデータです。
⚫ 2つのSARデータ
⚫ 1つのDEMデータ

◼ これらのデータは観測条件がすべて一致している必要があります。
⚫ 同じ衛星で取得したデータであること
⚫ 同じ軌道で取得したデータであること
⚫ 同じ観測モードで取得したデータであること

撮影された場所が微妙に違うので、
干渉処理を行うと干渉縞ができる

進行方向

出展 : 

日本リモートセンシング学会「基礎からわかるリモートセンシング」(理工図書株式会社)

講義用パワーポイント第１５章 SARの高度解析

視線方向

96
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SARインターフェロメトリ(干渉SAR)とは:
この干渉縞は何でできている？

97

◼ 干渉処理の最初にできるこの干渉縞を、初期干渉縞とよびます。

【構成要素】
1. 衛星の軌道が微妙にずれているために起きる干渉縞（軌道縞）
2. 地形の起伏で起きる干渉縞（地形縞）
3. 撮影する前後で地面に変動があったことで起きる干渉縞（変動縞）

初期干渉縞からこれらの情報を除いていき、
目的の情報を得るのが干渉処理の流れになります

出展 : 

日本リモートセンシング学会「基礎からわかるリモートセンシング」(理工図書株式会社)

講義用パワーポイント第１５章 SARの高度解析
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SARインターフェロメトリ(干渉SAR)とは:
処理の流れ

98

◼ 2つの複素数データから位置合わせして初期干渉縞をつくります。
⚫ 持っているのがRAWデータの場合、まず再生処理で複素数データをつくる

◼ 2つの軌道情報からシミュレートした軌道縞をつくります。
◼ 初期干渉縞からシミュレートした軌道縞を取り除き、干渉縞をつくる

進行方向

視線方向

初期干渉縞

シミュレートした軌道縞

干渉縞

進行方向

視線方向
出展 : 

日本リモートセンシング学会
「基礎からわかるリモートセンシング」(理工図書株式会社)

講義用パワーポイント第１５章 SARの高度解析

進行方向

視線方向
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SARインターフェロメトリ(干渉SAR)とは:
処理の流れ
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◼ 初期干渉縞とシミュレートした軌道縞の差でつくった干渉縞の構成
⚫ 地形の起伏で起きる干渉縞（地形縞）
⚫ 撮影する前後で地面に変動があったことで起きる干渉縞（変動縞）

▼地面の変動は発生していない、という視点で見る場合
変動縞は存在しない、という前提であるため、
この場合には干渉縞=地形縞なので、
干渉縞から地表面の高さ情報(DEM)を取得することができる

▼地面が撮影の前後で変動している、という視点で見る場合
この場合には干渉縞=地形縞 + 変動縞なので、
参考となるDEMでシミュレートした地形縞を差し引けば
地表面の変動情報を取得することができる

2通りの視点で結果を見ることができます

InSAR

DInSAR
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DInSAR Displacementワークフロー
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◼ SAR画像ペアからインターフェログラム（干渉画像）を作成し変動マップ作成
まで一連の処理を実行します。

1. インターフェログラムの作成

2. コヒーレンス画像作成と干渉フィルタ

3. 位相のアンラップ処理

4. 軌道補正と位相のオフセット計算

5. 変動マップの作成

処理の概要

101
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◼ 使用するデータは以下メニューからSARscapeへインポートします。
⚫ ENVI ツールボックス→ SARscape → Import Data → SAR Spaceborne

＊本トレーニング使用するデータはすでにSARscapeへインポート済みですので、
この手順は省略します。

使用するデータについて

102

◼ Bam地方のENVISAT ASAR IS2地震前後

⚫撮影時期: 2003年12月3日 / 2004年2月11日のペア

バム地震(2003 Bam earthquake)

• 2003年12月26日午前5時28分発生
• 震央はイラン南東部のケルマーン州バム
• マグニチュード6.6の直下型地震

テヘランタイムズ: 

https://www.tehrantimes.com/news/419753/On-the-

occasion-of-2003-Bam-earthquake
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Preferences specificの変更

◼ 先ほどの演習でSentinel TOPSAR (IW - EW)を使用していたので、ここでは
Generalという設定に変更してください。
◼ /SARscape/Preferences/Preferences specific

103
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まず干渉するデータペアかを確認

104

◼ Baseline Estimation: Normal Baseline / Critical Baseline

⚫ ENVI ツールボックス→ SARscape → Interferometry → Interferometric 

Tools → Baseline Estimation

◼ 選んだSAR画像のペアは、干渉処理ができるかを調べるツールです。

⚫注）得られた結果は参考値であり、処理の中で使用されるものではありま
せん。

垂直ベースライン距離（Normal Baseline）が、
干渉処理に適した理論値(Critical Baseline)の範囲
に収まるかどうかを確認してください。
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Baseline Estimationの確認
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1. ENVI ツールボックス→ SARscape → Interferometry → Interferometric Tools 

→ Baseline Estimationを選択し、設定ダイアログを起動します。
2. 出力結果を確認します。

⚫ Normal Baseline（垂直方向の距離）がCritical Baseline（臨界ベースライ
ン）の距離に収まっているか確認します。Critical BaselineよりNormal 

Baselineが大きくなった場合は、位相情報が大きく異なるため、二つの画
像を干渉させ、インターフェロメトリの処理を行うことができません。
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Baseline Estimation:
2 PI Ambiguity displacement (DInSAR) (m) 
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◼ 干渉縞1波長(2πサイクル)に対応する変位を表します。

⚫この数値が大きいほど、小さな変位の変化を検出する能力が粗くなります。

⚫これは使用している衛星の波長に依存し、衛星間の距離は影響しません。

⚫演習で使用しているENVISATの波長はおよそ 5.6cmなので……

𝜓2𝜋 =
𝜆

2

𝜓2𝜋 =
𝜆

2
=
5.6 × 10−2

2
= 0.028[𝑚]

このSAR画像ペアでは、1波長に対して
およそ0.028mの変動感度があると分かる
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Baseline Estimation:
2 PI Ambiguity height (InSAR) (m)

107

◼ 干渉縞1波長(2πサイクル)に対応する高さを表します。

⚫この数値が大きいほど、小さな高さの変化を検出する能力が粗くなります。

⚫衛星間の距離が離れているほど高さ方向の検出精度は高くなります。

𝜙 =
4𝜋𝐵𝑛

𝜆𝑅𝑠𝑖𝑛(𝜃)
ℎ

𝜙=2𝜋
ℎ2𝜋 =

𝜆𝑅𝑠𝑖𝑛 𝜃

2𝐵𝑛

𝐵𝑛:垂直ベースライン距離
𝜆:観測衛星の波長
𝑅: スラントレンジ距離
𝜃: Masterの入射角

ℎ2𝜋 =
𝜆𝑅𝑠𝑖𝑛 𝜃

2𝐵𝑛
=
5.6 × 10−2 × 849807.494 × sin(23.457 𝑑𝑒𝑔)

2 × 3.773
≈ 2521[𝑚]

このSAR画像ペアでは、1波長に対して
およそ2521mの高さ感度があると分かる

⚫演習で使用しているENVISATの波長はおよそ 5.6cmなので……
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2 PI Ambiguity height (InSAR) (m)の値と
InSAR / DInSAR処理の向き不向きについて

108

◼ ベースラインが長い(2 PI Ambiguity heightが小) とInSAR処理に向いています。
⚫ 1波長あたりの感度が大きいので、高さ方向での精度が出やすい傾向

◼ ベースラインが短い(2 PI Ambiguity heightが大) とDInSAR処理に向いています。

⚫ ベースラインが長い場合、高さ方向で感度が良くなってしまうため使用し
ている参照DEMの影響を受けやすくなることが原因

◼ (あくまで目安だが) 2 PI Ambiguity height を10分の1した値が1桁になるような
高さ感度の場合、DInSAR処理には向いていません。
⚫ 2PI Ambiguity heightはBaseline Estimationの結果に出力される

参考: 例えば ALOS-2やSentinel-1のような衛星は軌道毎の衛星間距離が一定の範
囲内に収まる(ベースラインが短い = 2 PI Ambiguity heightが大きい)ため、
DInSARの処理には向いています。(InSARには不向きです)
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DInSAR Displacementワークフロー: 演習
Input ステップ

109

1. ENVI ツールボックス→ SARscape → Interferometry → DInSAR

Displacement Workflowを選択し、DInSARワークフローダイアログを起動し
てください。

2. Inputダイアログの設定は以下のようになります。左側にワークフロー内の処
理ステップのリストが表示されます。Inputステップダイアログで、入力ファ
イルとDEMを指定します。

3. InputステップのParametersタブ→ 以下の値を設定し、Nextボタンをクリック
してください。

【設定値】
Input Fileタブ
Master File: 

C:¥Training¥SARscape¥DInSAR¥3dec03_slc

Slave File:

C:¥Training¥SARscape¥DInSAR¥11feb04_slc

DEM/Cartographic Systemタブ
DEM file:

C:¥Training¥SARscape¥DInSAR¥srtm25_dem
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DInSAR Displacementワークフロー: 演習
Import Generic SAR Data ステップ
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1. 事前にSLCにインポートしていない場合、ワークフロー内でもオリジナルデー
タからインポートが可能です。この演習ではSample Selectionの工程をスキッ
プしますので「Skip Sample Selection」パラメータはTrueに変更し、
「Next」をクリックしてください。
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DInSAR Displacementワークフロー: 演習
Interferogram Generation ステップ

111

◼ 干渉画像を作成ステップです。
⚫ SARscapeではアンラップのために、軌道縞・地形縞の除去をここで行い
ます。

⚫ _intという中間ファイルは、これらの情報が除去されていない画像です。

強度画像(_pwr) 干渉画像(_int) 平坦化された干渉画像
(_dint)
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DInSAR Displacementワークフロー: 演習
Interferogram Generation ステップ
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1. インターフェログラム生成のステップです。初期干渉画像と軌道縞・地形縞除
去を行います。以下の設定値を入力し、左下のPreviewにチェックを入れて、
「Next」をクリックして次ステップへ進みます。

【設定値】
Range Looks: 1

Azimuth Looks: 4

補足: Previewにチェックを入れると、以下の中間処理結果のテンポラリ画像がENVIに表示されます。
INTERF_out_master_pwr: 3dec03_slcの強度画像
INTERF_out_slave_pwr: 11feb04_slcの強度画像
INTERF_out_dint: 軌道縞等の除去後のインターフェログラム画像
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DInSAR Displacementワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ
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◼ コヒーレンス画像作成と干渉画像のフィルタリングのステップです。

ペアの各点がどのくらい似ているか、という類似度を
0から1の範囲で表したもの。1に近いほど類似度が高い。

本データでコヒーレンスの低い場所では、
地震前後の変化が大きかった可能性が考えられる。

◼ コヒーレンスを計算する目的は以下です。
1. 測定(干渉位相)の品質を特定する
2. 後方散乱係数と併せ、地上のオブジェクトに関する情報を抽出する
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DInSAR Displacementワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ
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✓ コヒーレンス画像作成と干渉画像のフィルタリングのステップです。

コヒーレンス値を使用して
様々な地物に対して
個々にフィルタ処理が実行される
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DInSAR Displacementワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ
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1. コヒーレンス画像作成と干渉画像のフィルタリングのステップです。パラメー
タはデフォルトの「Goldstein」のまま「Next」をクリックして次のステップ
へ進みます。

補足: Previewにチェックを入れると、以下の中間処理結果のテンポラリ画像がENVIに表示されます。
INTERF_out_cc: コヒーレンス画像
INTERF_out_fint: ノイズ除去後のインターフェログラム画像

コヒーレンス画像(_cc) ノイズ除去後のイン
ターフェログラム画像

(_fint)
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DInSAR Displacementワークフロー: 演習
Phase Unwrapping ステップ
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◼ ここまでに生成された干渉画像は、各ピクセルが[-3.14, 3.14]の値(周期2π)にな
ります。
⚫ つまり、[-3.14, 3.14]の範囲に値が折り畳まれて(wrap)います。

◼ この折り畳まれている状態を解いて(unwrap) 、周期的な変化を直線的な変化に
戻す処理をアンラップといいます。

半波長

半波長

π

-π
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DInSAR Displacementワークフロー: 演習
Phase Unwrapping ステップ
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1. インターフェログラム生成のステップです。初期干渉画像と軌道縞・地形縞除
去を行います。以下の設定値を入力し、左下のPreviewにチェックを入れて、
「Next」をクリックして次ステップへ進みます。

【設定値】
Unwrapping Method Type: Minimum 

Cost Flow

Unwrapping Decomposition Level: 1

Unwrapping Coherence Threshold: 0.3

補足: Previewにチェックを入れると、以下の中間処理結果のテンポラリ画像がENVIに表示されます。
INTERF_out_upha:フェーズアンラップ画像
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DInSAR Displacementワークフロー: 演習
GCP Selection ステップ
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◼ 次に行うRefinement and Re-flatteningの処理に必要なGCP(Ground Control 

Point: 地上基準点)を設定します。

⚫ 干渉の色が大きく変化する箇所やコヒーレンスの低い場所は避けて取得し
ます。

◼ 目的: 不動点を指定するため

この場所は動いてない、というポイント(不動点)を指定する
約4-5点程度 (可能なら、安定構造物や動いていないことが既知の点を採
用)。

軌道補正の意味もあるので、ここでも可能な限り広域で取ることが望ま
しい。

本来は動いていない(と考えられる)場所が、動いていると判断されている
⚫ アンラップ画像は、周期的な位相変化を直線的な変動量に変えたもの

⚫ 本来は動いていない場所であっても、アンラップ直後の画像では動い
ていると計算されてしまっている箇所もある



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

DInSAR Displacementワークフロー: 演習
GCP Selection ステップ
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1. GCPの設定ダイアログを起動します。双眼鏡アイコンをクリックしてくださ
い。

2. Generate Ground Control Pointsダイアログが開きます。ファイル選択は以下
の設定値をBrowseから選択して「Next」をクリックします。

【設定値】
Input file: INTERF_out_fint

DEM file: start_dem

Reference file: INTERF_out _cc



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

DInSAR Displacementワークフロー: 演習
GCP Selection ステップ
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3. レイヤーマネージャの「INTERF_out_cc」を右クリックし、Change Color 

Table → Rainbow を選択してください。GCPの設定ダイアログを起動します。
双眼鏡アイコンをクリックしてください。

4. 「INTERF_out_fint」レイヤーを選択し、 透過のスライダーでレ
インボーカラーのコヒーレンス画像が見えるように設定してください。
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DInSAR Displacementワークフロー: 演習
GCP Selection ステップ
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5. GCPの設定

⚫ コヒーレンスが高い（赤く透ける箇所）ポイントに加え、位相情報が安定
（フリンジを越えずある程度値が一定な箇所）している場所をポイントと
して設定します。

⚫ ポイントを設定する際は、左マウスボタンで画像内の任意の場所をクリッ
クしてください。

⚫ 画像全体に均一に3~5ポイントを取るように設定してください。
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DInSAR Displacementワークフロー: 演習
GCP Selection ステップ
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6. GCPを保存します。ポイントが取り終わりましたら、Generate Ground 

Control Points ダイアログに戻ります。Export タブでOutput XML File に任意
のファイル名を設定できます。「Finish」ボタンをクリックしてください。

7. ワークフローに戻り、Refinement GCP Fileに今作成したファイル名が入力さ
れていることを確認して「Next」をクリックします。
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DInSAR Displacementワークフロー: 演習
Refinement and Re-flattening ステップ

123

◼ GCPの情報を使用して補正を行うステップです。
⚫ フィルタ処理を行った後の干渉画像(_fint)およびアンラップ画像(_upha)に
対して補正を行った結果が表示されます。

◼ 使用した関数や誤差については、処理後に表示されるRefinement Resultウィン
ドウに表示されます。
⚫ 中間生成物として、同様のものがtxt形式で保存されています。
⚫ デフォルトの手法 Polynomial Refinement ではResidual Phase Poly 

Degreeの項目に設定している数のGCP点が最低でも必要となる(初期値:3)

GCPを設定し
補正を行う
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DInSAR Displacementワークフロー: 演習
Refinement and Re-flattening ステップ
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1. 設定値を確認して「Next」をクリックして次へ進みます。

【設定値】
Refinement Method: Polynomial Refinement

Refinement Res Phase Poly Degree: 3

Coregistration With DEM: False

補足: Previewにチェックを入れると、以下の中間処理結果のテンポラリ画像がENVIに表示されます。
INTERF_out_reflat_fint: リフラットしたノイズ除去干渉画像
INTERF_out_reflat_upha:リフラットしたフェーズアンラップ画像
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DInSAR Displacementワークフロー: 演習
Refinement and Re-flattening ステップ
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2. 結果の確認

Refinement結果

リフラットしたノイズ除去インター
フェログラム画像（擬似カラー）

リフラットしたフェーズアンラップ
画像（擬似カラー）
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DInSAR Displacementワークフロー: 演習
Phase to Displacement Conversion ステップ
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◼ ジオコーディングした変動マップデータを作成するステップです。

⚫ 各ピクセルの値は、2時期の画像間のSARの視線方向の変動量(m)を表しま
す。

⚫ 衛星に近づく方向が正、衛星から遠ざかる方向が負の値となります。
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DInSAR Displacementワークフロー: 演習
Phase to Displacement Conversion ステップ
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◼ Phase to Displacement ConversionにはVertical / Slope Displacementというパ
ラメータが含まれます。

◼ これは視線方向の変位がすべて水平 / 垂直方向に移動していたとしたと仮定し
た場合に理論上成り立つ水平 / 垂直方向の変化量を示したものである

地盤変動 Vertical

Slope

視線方向に対する垂線
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DInSAR Displacementワークフロー: 演習
Phase to Displacement Conversion ステップ
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1. Principal Parametersはデフォルトのまま、Geocoding ParametersのRelax 

InterpolationとDummy Removalを「True」にして「Next」をクリックします。

【設定値】
Product Coherence Threshold: 0.3

X Dimension (m): 25(任意)

Y Dimension (m): 25(任意)

補足: 垂直方向やスロープ方向へ逆投影した変動結果を出力する場合はVertical Displacement、Slope Displacementを
Trueにしてください。
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DInSAR Displacementワークフロー: 演習
Output ステップ
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1. Output Root Nameに任意のベースファイル名を入力し「Finish」をクリックし
ます。Delete Temporary Filesにチェックを入れたままにしておくと、今まで
Preview用に作成したテンポラリファイルを削除します。

補足:各ピクセルの値は、2時期の画像間のSARの視線方向の変動(m)で、衛星に近づく方向が正、衛星から遠ざかる
方向が負となります。
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参考: InSAR DEMワークフロー
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◼ 地面の変動は発生していない、という視点で見ると変動縞(=地形縞)から標高
データ（DEM）を作成することができます
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さらに学習したい人のために

✓弊社HPでは、SARscapeの基本操作手順書を提供しています

✓今回紹介した地理院DEMのインポート手順書などもこちらから入手できます

131

弊社HP https://www.harrisgeospatial.co.jp/

ナビゲーションバー > 技術情報 > 技術資料(日本語)

> SARscape基本操作手順書の一覧（強度画像、PS、SBAS、GCPなど）

https://www.harrisgeospatial.co.jp/
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問い合わせ先

Harris Geospatial 株式会社では、ENVI 及びその他の製品に関する技術サ
ポート、お客様の使用事例などの情報を提供しています。

Harris Geospatial 製品・サポート連絡先
E-mail：
support_jp@L3harris.com

Home Page：
https://www.harrisgeospatial.co.jp/
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補足スライド
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補足演習1:
Intensity Time Series ワークフロー

134



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

SARscapeでの基本処理手順: 
Intensity Time Series ワークフロー

135

◼ Basic モジュールを利用してSAR画像を扱う上で必ず必要になるデータ処理方
法について説明します。

◼ SAR画像はSLC（Single Look Complex）データの状態では地物の判別などが
難しく、画像解析を実施するためにいくつかの処理を必要とします。

◼ インポートしたSLC（Single Look Complex）データからマルチルック(強度画
像の作成)、コレジストレーション(位置合わせ)、フィルタ処理、ジオコーディ

ングまでの基本処理を一連の作業として実施するワークフローが用意されてい
ます。

⚫ マルチルック
⚫ コレジストレーション
⚫ フィルタ
⚫ 時系列データの解析
⚫ ジオコーディング
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Intensity Time Series ワークフロー: 演習
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◼ 同一シーンの複数時期のデータを扱いますが、すべて読み込みから行うと時間
がかかりますので、既に小さなサイズに切り取ったSLCデータを利用して処理
を行います。

◼ 柏市から成田市あたりまでの範囲のSAR SLCデータを使用します。
2009年12月04日、 2010年04月21日、2010年06月06日
2010年07月22日、 2010年09月06日、2010年10月22日の6シーン
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Intensity Time Series ワークフロー: 演習
Input ステップ
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1. 「palsar_fbs_full_slc」を表示している場合は、データマネージャでファイル
を閉じてください。

2. ENVI ツールボックス→ SARscape → Basic→ Intensity Time Series Workflow 

を選択し、ワークフローダイアログを起動してください。ワークフローダイア
ログは以下のようになります。左側にワークフロー内の処理ステップのリスト
が表示されます。
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Intensity Time Series ワークフロー: 演習
Input ステップ
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3. InputステップのInput Fileタブ→ 以下のファイルを全て選択してください。

4. InputステップのDEM/Cartographic Systemタブ→ 以下のファイルを選択して
ください。

5. InputステップのParametersタブ→ 以下の値を設定し、Nextボタンをクリック
してください。

補足: DEMファイルの事前用意が無い場合、ワークフロー内でインターネット経由のダウンロードで取得することも
可能です。98ページ以降にツールの詳細を紹介しています。

【設定値】
C:¥Training¥SARscape¥PALSAR¥SLC¥20091204_slc

C:¥Training¥SARscape¥PALSAR¥SLC¥20100421_slc

C:¥Training¥SARscape¥PALSAR¥SLC¥20100606_slc

C:¥Training¥SARscape¥PALSAR¥SLC¥20100722_slc

C:¥Training¥SARscape¥PALSAR¥SLC¥20100906_slc

C:¥Training¥SARscape¥PALSAR¥SLC¥20101022_slc

【設定値】
C:¥Training¥SARscape¥PALSAR¥DEM¥srtm_dem

【設定値】
Skip Import SAR Data: True

Skip Sample Selection: True

Grid Size: 6.5
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Intensity Time Series ワークフロー: 演習
Import Generic SAR Dataステップ
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1. 事前にSLCにインポートしていない場合、ワークフロー内でもオリジナルデー
タからインポートが可能です。主にSentinel-1に関して、興味範囲に関連する

必要バーストのみをインポートする等のインポートパラメータ調整を行えます。
ワークフロー内でインポートする場合は、Input ステップでオリジナルSAR

データを指定します。

この演習では
Skip Sample SelectionをTrueとします
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Intensity Time Series ワークフロー: 演習
Multilookingステップ
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1. Principal Parametersの各項目が【設定値】の通りであることを確認して、
Previewチェックボックスにチェックを入れて「Next」をクリックします。

2. 処理が完了すると、ENVI上に*_pwrと接尾子のついた各入力ファイルの強度画

像が表示されます。レイヤーマネージャで各レイヤーを確認すると、位置にず
れがあることが確認できます。

【設定値】
Multilooking Method: Time Domain

Range Multilook: 1

Azimuth Multilook: 2

Grid Size for Suggested Looks: 6.5

補足: SARscapeは、ワークフロー処理で生成される中間処理画像ファイルを、Preferences で指定したTemp 

Directory 内にSARsTmpDir***という作業フォルダを作成して格納します。ワークフローの最後でこれらの中間ファイ
ルを削除するか選択することができます。削除しない場合は、上記作業フォルダはOutput Directory 内にwf_temp_***

というフォルダ名に変更の上保存されます。
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Intensity Time Series ワークフロー: 演習
Coregistraionステップ
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1. デフォルトで「Coregistration With DEM」がFalseになっていますのでそのま
ま「Next」をクリックしてください。

2. 処理が完了すると、ENVI上に*_rspと接尾子のついた各強度画像の位置合わせ
された画像群が表示されます。レイヤーマネージャの表示/非表示切り替えや

透過度を変更して各レイヤーの位置にずれがなくなったことを確認してくださ
い。
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Intensity Time Series ワークフロー: 演習
De Grandi Spatial-Temporal Filtering ステップ
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1. パラメータはデフォルトのまま「Next」をクリックしてください。
2. 処理が完了すると、ENVI上に*_filと接尾子のついた位置合わせされた各強度画

像のフィルタリングされた画像群が表示されます。レイヤーマネージャの表示
/非表示切り替えや透過度を変更して同一日付の*_rspと*_filのペアを比較しま

しょう。河川の部分など、ごま塩状のスペックルノイズが軽減されていること
がわかります。
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Intensity Time Series ワークフロー: 演習
Geocoding and Radiometric Calibration ステップ
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1. パラメータはデフォルトのまま「Next」をクリックしてください。
2. 処理が完了すると、ENVI上に*_geoと接尾子のついたジオコーディングされた
画像群が表示されます。ENVIのステータスバーに地理情報が表示されている
ことが確認できます。SAR画像に付加される投影情報はDEMデータが持つ投
影情報となります。
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Intensity Time Series ワークフロー: 演習
Multi Temporal Features ステップ
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◼ 入力した時系列SARデータの統計計算など特徴抽出します。
1. パラメータはデフォルトのまま「Next」をクリックしてください。

⚫ Make cmg RGBフラグこのフラグを設定すると、以下をRGB合成画像と
して生成してくれます。(デフォルト:True)

• 変動係数 (Coefficient of Variation)

• 最⼩値 (Min)

• 勾配 (Gradient)
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Intensity Time Series ワークフロー: 演習
Output ステップ
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◼ ファイルの出力先を指定し、MultilookやCoregistration、フィルタステップな
どのジオコーディング以前の中間処理ファイルの削除設定を行います。

1. Output Root Nameに任意のファイル名を設定して「Delete Temporary Files」
にチェックを入れて「Finish」をクリックしてください。パラメータはデフォ
ルトのまま「Next」をクリックしてください。

【設定値】
C:¥Training¥SARscape¥Output¥ITS_mt_feature
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Intensity Time Series ワークフロー: 演習
Output ステップ
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2. 処理が完了すると、レイヤーマネージャにあった中間ファイルは削除され、出
力した*_mt_feature_metaファイルが表示されます。*_metaファイルには、
Band1～Band6までに各日付のジオコーディング画像と、Band7以降にMulti-

Temporal Featuresで設定したバンドが含まれています。また、Make cmg

RGBがTrueになっていると、Coefficient of Variation, Min, Gradient をRGBに
割り当てたTIFFが作成されます。
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Intensity Time Series ワークフロー: 
出力ファイル

147

◼ Make cmg RGBフラグをTrueに設定して出力された
intensity_CovMinGrad_rgb.tifファイルを確認します。

変動係数(Coefficient of 
Variation)

最⼩値(Min)

勾配(Gradient)
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Intensity Time Series ワークフロー: 
変動係数: Coefficient of Variation
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◼ 標準偏差 / 平均値→ばらつきの大きさ
◼ 時間毎に変化していく場所では、この値が大きくなります。

変動係数(Coefficient of 
Variation)

最⼩値(Min)

勾配(Gradient)
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Intensity Time Series ワークフロー: 
最小値: Min
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◼ 入力期間での最小値
◼ 強い反射のある構造物などでは、最小値自体が大きくなります。

変動係数(Coefficient of 
Variation)

最⼩値(Min)

勾配(Gradient)
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Intensity Time Series ワークフロー: 
勾配: Gradient
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◼ 連続する2時期での最大となる変動量
◼ 変化の著しい場所では、この値が大きくなります。

変動係数(Coefficient of 
Variation)

最⼩値(Min)

勾配(Gradient)



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

補足演習2:
InSAR DEMワークフロー

151
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処理の概要

152

◼ SAR画像ペアからインターフェログラム（干渉画像）を作成しDEM作成まで
一連の処理を実行します。

1. インターフェログラムの作成

2. コヒーレンス画像作成と干渉フィルタ

3. 位相のアンラップ処理

4. 軌道補正と位相のオフセット計算

5. 標高データ(DEM)の作成
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使用するデータについて
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◼ ラスベガス周辺のENVISAT ASAR IS4 データ

⚫ 撮影時期: 2002 年11月7日 / 2003年1月16日のペア

⚫ ENVI ツールボックス→ SARscape → Preferences → Preferences 

specific → General

◼ 使用するデータは以下メニューからSARscapeへインポートします。
⚫ ENVI ツールボックス→ SARscape → Import Data → SAR Spaceborne

＊本トレーニング使用するデータはすでにSARscapeへインポート済みですので、
この手順は省略します。
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Baseline Estimationの確認
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1. ENVI ツールボックス→ SARscape → Interferometry → Interferometric Tools 

→ Baseline Estimationを選択し、設定ダイアログを起動します。
2. 出力結果を確認します。

⚫ Normal Baseline（垂直方向の距離）がCritical Baseline（臨界ベースライ
ン）の距離に収まっているか確認します。Critical BaselineよりNormal 

Baselineが大きくなった場合は、位相情報が大きく異なるため、二つの画
像を干渉させ、インターフェロメトリの処理を行うことができません。
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InSAR DEMワークフロー: 演習
Input ステップ
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1. ENVI ツールボックス→ SARscape → Interferometry → InSAR DEM Workflow

を選択し、InSAR DEMワークフローダイアログを起動してください。
2. Inputダイアログの設定は以下のようになります。左側にワークフロー内の処
理ステップのリストが表示されます。Inputステップダイアログで、入力ファ
イルとDEMを指定します。

【設定値】
Input Fileタブ
Master File: 

C:¥Training¥SARscape¥reference¥InSAR_Input¥DORIS¥7_1

1_02_slc

Slave File:

C:¥Training¥SARscape¥reference¥InSAR_Input¥DORIS¥16_

01_03_slc

DEM/Cartographic Systemタブ
DEM file:

C:¥Training¥SARscape¥reference¥InSAR_Input¥start_dem
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InSAR DEMワークフロー: 演習
Input ステップ
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3. InputステップのParametersタブ→ 以下の値を設定し、Nextボタンをクリック
してください。

【設定値】
Grid Size: 25.00
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InSAR DEMワークフロー: 演習
Import Generic SAR Data ステップ
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1. 事前にSLCにインポートしていない場合、ワークフロー内でもオリジナルデー
タからインポートが可能です。この演習ではSample Selectionの工程をスキッ
プしますので、「Skip Sample Selection」パラメータをTrueにして「Next」
をクリックしてください。
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InSAR DEMワークフロー: 演習
Interferogram Generation ステップ
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◼ 干渉画像を作成ステップ
⚫ SARscapeではアンラップのために、軌道縞・地形縞の除去をここで行い
ます。

⚫ _intという中間ファイルは、これらの情報が除去されていない画像です。

強度画像(_pwr) 干渉画像(_int)
平坦化された干渉画像

(_dint)



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

InSAR DEMワークフロー: 演習
Interferogram Generation ステップ
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1. インターフェログラム生成のステップです。初期干渉画像と軌道縞・地形縞除
去を行います。以下の設定値を入力し、左下のPreviewにチェックを入れて、
「Next」をクリックして次ステップへ進みます。

【設定値】
Range Looks: 1

Azimuth Looks: 4

補足: Previewにチェックを入れると、以下の中間処理結果のテンポラリ画像がENVIに表示されます。
INTERF_out_master_pwr: 7_11_02_slcの強度画像
INTERF_out_slave_pwr: 16_01_03_slcの強度画像
INTERF_out_dint: 軌道縞等の除去後のインターフェログラム画像
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InSAR DEMワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ
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◼ コヒーレンス画像作成と干渉画像のフィルタリングのステップです。

ペアの各点がどのくらい似ているか、という類似度を
0から1の範囲で表したもの。1に近いほど類似度が高い。

本データでコヒーレンスの低い場所は、
Google Earthで確認すると、未舗装の道路だった。

◼ コヒーレンスを計算する目的は以下です。
1. 測定(干渉位相)の品質を特定する
2. 後方散乱係数と併せ、地上のオブジェクトに関する情報を抽出する
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InSAR DEMワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ
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◼ コヒーレンス画像作成と干渉画像のフィルタリングのステップです。

コヒーレンス値を使用して
様々な地物に対して
個々にフィルタ処理が実行される
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InSAR DEMワークフロー: 演習
Adaptive Filter& Coherence Generation ステップ
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1. コヒーレンス画像作成と干渉画像のフィルタリングのステップです。パラメー
タはデフォルトの「Goldstein」のまま「Next」をクリックして次のステップ
へ進みます。

補足: Previewにチェックを入れると、以下の中間処理結果のテンポラリ画像がENVIに表示されます。
INTERF_out_cc: コヒーレンス画像
INTERF_out_fint: ノイズ除去後のインターフェログラム画像

コヒーレンス画像(_cc) ノイズ除去後のイン
ターフェログラム画像

(_fint)
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InSAR DEMワークフロー: 演習
Phase Unwrapping ステップ
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◼ ここまでに生成された干渉画像は、各ピクセルが[-3.14, 3.14]の値(周期2π)にな
ります。
⚫ つまり、[-3.14, 3.14]の範囲に値が折り畳まれて(wrap)います。

◼ この折り畳まれている状態を解いて(unwrap) 、周期的な変化を直線的な変化に
戻す処理をアンラップといいます。

半波長

半波長

π

-π
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InSAR DEMワークフロー: 演習
Phase Unwrapping ステップ
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1. インターフェログラム生成のステップです。初期干渉画像と軌道縞・地形縞除
去を行います。以下の設定値を入力し、左下のPreviewにチェックを入れて、
「Next」をクリックして次ステップへ進みます。

【設定値】
Unwrapping Method Type: Minimum 

Cost Flow

Unwrapping Decomposition Level: 1

Unwrapping Coherence Threshold: 0.3

補足: Previewにチェックを入れると、以下の中間処理結果のテンポラリ画像がENVIに表示されます。
INTERF_out_upha:フェーズアンラップ画像
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InSAR DEMワークフロー: 演習
GCP Selection ステップ
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◼ 次に行うRefinement and Re-flatteningの処理に必要なGCP(Ground Control 

Point: 地上基準点)を設定します。

⚫ 干渉の色が大きく変化する箇所やコヒーレンスの低い場所は避けて取得し
ます。

◼ 目的: 参照DEMで取りきれないノイズの除去と軌道補正のため

干渉SARの結果に手動で位置情報を与え、これらの誤差を除去する
広く画像全体で、およそ20点程度のGCPを取得する

地形情報(DEM)を求める際に含まれる誤差の原因
大気中には水蒸気などの微粒子があることで、位相遅延の原因になる

使用した衛星ペアは完全に平行な軌道で同じ場所を観測してはいないた
め、相対的なズレがどうしても含まれる
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InSAR DEMワークフロー: 演習
GCP Selection ステップ
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1. GCPの設定ダイアログを起動します。双眼鏡アイコンをクリックしてくださ
い。

2. Generate Ground Control Pointsダイアログが開きます。ファイル選択は以下
の設定値をBrowseから選択して「Next」をクリックします。

【設定値】
Input file: INTERF_out_fint

DEM file: start_dem

Reference file: INTERF_out _cc
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InSAR DEMワークフロー: 演習
GCP Selection ステップ
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3. レイヤーマネージャの「INTERF_out_cc」を右クリックし、Change Color 

Table → Rainbow を選択してください。GCPの設定ダイアログを起動しま
す。双眼鏡アイコンをクリックしてください。

4. 「INTERF_out_fint」レイヤーを選択し、 透過のスライダーでレ
インボーカラーのコヒーレンス画像が見えるように設定してください。
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InSAR DEMワークフロー: 演習
GCP Selection ステップ
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5. GCPの設定

⚫ コヒーレンスが高い（赤く透ける箇所）ポイントに加え、位相情報が安定
（フリンジを越えずある程度値が一定な箇所）している場所をポイントと
して設定します。

⚫ ポイントを設定する際は、左マウスボタンで画像内の任意の場所をクリッ
クしてください。

⚫ 画像全体に均一にポイントを10点程度取るように設定してください。
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InSAR DEMワークフロー: 演習
GCP Selection ステップ
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6. GCPを保存します。ポイントが取り終わりましたら、Generate Ground 

Control Points ダイアログに戻ります。Export タブでOutput XML File に任意
のファイル名を設定できます。「Finish」ボタンをクリックしてください。

7. ワークフローに戻り、Refinement GCP Fileに作成したファイル名が入力され
ていることを確認して「Next」をクリックします。
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InSAR DEMワークフロー: 演習
Refinement and Re-flattening ステップ
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◼ GCPの情報を使用して補正を行うステップです。
⚫ フィルタ処理を行った後の干渉画像(_fint)およびアンラップ画像(_upha)に
対して補正を行った結果が表示されます。

◼ 使用した関数や誤差については、処理後に表示されるRefinement Resultウィン
ドウに表示されます。
⚫ 中間生成物として、同様のものがtxt形式で保存されます。
⚫ デフォルトの手法 Polynomial Refinement ではResidual Phase Poly 

Degreeの項目に設定している数のGCP点が最低でも必要となる(初期値:3)

➢ 他手法では最低7点必要で、7点に満たない場合、他手法を設定してい
ても自動的にPolynomial Refinementが使用されます。

GCPを設定し
補正を行う
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InSAR DEMワークフロー: 演習
Refinement and Re-flattening ステップ
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1. 設定値を確認して「Next」をクリックして次へ進みます。

【設定値】
Refinement Method: Polynomial Refinement

Refinement Res Phase Poly Degree: 3

Coregistration With DEM: False

補足: Previewにチェックを入れると、以下の中間処理結果のテンポラリ画像がENVIに表示されます。
INTERF_out_reflat_fint: リフラットしたノイズ除去干渉画像
INTERF_out_reflat_upha:リフラットしたフェーズアンラップ画像
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InSAR DEMワークフロー: 演習
Refinement and Re-flattening ステップ
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2. 結果の確認

Refinement結果

リフラットしたノイズ除去インター
フェログラム画像（擬似カラー）

リフラットしたフェーズアンラップ
画像（擬似カラー）
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InSAR DEMワークフロー: 演習
Phase to Height Conversion ステップ

173

◼ 位相差を高さ情報に変換するステップです。
⚫ ジオコーディングした標高データ（DEM）が作成されます。
⚫ Output TypeがEllipsoidal(デフォルト値)だと楕円体高で、Ellipsoidal and 

Geoidalだと楕円体高と標高値の双方で出力されます。
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InSAR DEMワークフロー: 演習
Phase to Height Conversion ステップ

174

1. 出力値は、Output Typeをデフォルトの「Ellipsoidal」だと楕円体高に、
「Ellipsoidal and Geoidal」にすると、楕円体高と標高値の双方を出力します。
設定値を確認して「Next」をクリックして次へ進みます。

【設定値】
Product Coherence Threshold: 0.2

X Dimension (m): 25(任意)

Y Dimension (m): 25(任意)
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InSAR DEMワークフロー: 演習
Output ステップ
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1. Output Root Nameに任意のベースファイル名を入力し「Finish」をクリックし
ます。Delete Temporary Filesにチェックを入れたままにしておくと、今まで
Preview用に作成したテンポラリファイルを削除します。

補足: DEMファイルと同時に出力ディレクトリには*_precisionファイルと*_resolutionファイルが作成されます。
*_precisionファイルはDEMデータの各ピクセルの信頼度を示し、低い値を持つピクセルが信頼度の高いデータ

となります。
*_resolutionファイルは、入射角角に基づいた各ピクセルの解像度となります。
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補足:
各種ツールや用語について

176



L3HARRIS 衛星リモートセンシング・データ解析 ~SARscape入門~

代表的なディスプレイツール①

アイコン 機能

ENVI 標準フォーマットのファイルオープンの機能です。メニュー
バー > File > Openと同じ動作をします。

読み込まれたデータの管理を行う、Data Managerを起動します。

現在のENVIビューに表示されている画像をパワーポイントにクリップ
します。

スクロールビューボタンが表示され、ENVIビューに表示されている範
囲(倍率)を保ちカーソルで指定した方向へ画像内を移動できます。

カーソル位置のピクセル情報を表示するCursor Value を起動する機能
です。
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代表的なディスプレイツール②

アイコン 機能

選択機能です。イメージウィンドウ内に描画された注釈等を選択しま
す。また、フライ、回転といったその他の機能をオフにします。

パン機能です。イメージウィンドウ内にて左マウスボタンをドラッグ
し、画像を移動させます。マウスのセンターホイールを押下した時と
同じ動きをします。

フライ機能です。イメージウィンドウ内にて左マウスボタンをクリッ
クし続けると、矢印の方向に画像が移動し続けます。

回転機能です。イメージウィンドウ内にて左マウスボタンをドラッグ
すると、ドラッグした方向に画像が回転します。

ズーム機能です。指定エリアのズーム、ズームイン、ズームアウト、
画像全体の表示、パーセンテージでの画像の倍率変更が可能です。マ
ウスのセンターホイールを前後へ回した時と同じ動きをします。
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代表的なディスプレイツール③

アイコン 機能

画像の北を上に表示する機能です。地図情報を保持している画像のみ
に有効です。

回転機能です。角度を入力して画像を回転できます。

ピクセル値表示機能です。表示画像の任意の指定ポリライン断面のピ
クセル値をプロットします。

ピクセル値表示機能です。選択ピクセルの表示画像データの全てのバ
ンドのピクセル値をプロット(スペクトルプロファイルを表示)します。

2 バンドのバンド相関図を表示する2D Scatter Plot機能です。

クラス画像を編集する機能です。
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代表的なディスプレイツール④

アイコン 機能

ROI ツールです。ROI の作成、編集をする際にROI ツールを起動しま
す。

オブジェクトをカウントするFeature Counting という機能です。数値

的に記録しておきたいものにマークを付け、位置と数をカウントしま
す。

ベクタツールです。ベクタの作成、編集等ができます。

テキスト、ポリゴン、スケールバー、グリッドライン等各種アノテー
ションを作成する機能です。

指定した座標の位置へと移動する機能です。

輝度の調整機能です。スライダーバーを移動させ、輝度の調整をおこ
ないます。
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代表的なディスプレイツール⑤

アイコン 機能

コントラストの調整機能です。スライダーバーを移動させ、コントラ
ストの調整を行います。

左のアイコンがストレッチを画像全体にかけるよう指定し、右のアイ
コンは表示領域のみにかける指定を行います。中央のアイコンは、ス
トレッチの表示領域の変更に伴いを自動更新する機能です。

ストレッチの種類を選択し、画像にストレッチをかける機能です。ド
ロップダウンリストからストレッチの方法を選択します。

ストレッチの調整機能です。画像のヒストグラムをみながら、スト
レッチの調整できます。

シャープネスの調整機能です。スライダーバーを移動させ、シャープ
ネスの調整を行います。

透過度の調整機能です。スライダーバーを移動させ、透過度の調整を
行います。
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代表的なディスプレイツール⑥

アイコン 機能

パラメータを変更した設定の値をデフォルト値へと戻します。

測定したい箇所の画像上の始点と終点をクリックし、距離を表示しま
す。

レイヤーが二つ以上になると、Portal ボタンが有効になります。ポー
タルウィンドウボタンの横には他の表示方法として、Blend・
Flicker・Swipe ボタンがあります。

Mensuration tool 
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ストレッチの種類について

項目名 説明

Linear(線形変換) 設定されたパーセンテージによる線形補間を行います。

Equalize(平坦化) 各ヒストグラムのビンに入る、ピクセルの数を平等にし、
ストレッチを行う。

Gaussian(ガウシアン) 入力データの平均値を画像の127 とし、第三標準偏差を0 

と255 にし、残りのデータはガウシアンカーブに基づい
てデータを割り振ります。

Square Root(平方根) インプットのヒストグラムに対して、平方根をとりそれ
に対して、線形変換を行う。

Logarithmic(対数) 低域の輝度を強調する非線形手法です。

Optimized Linear(最適化線形) 線形補間に類似していますが、中間色、シャドウ、ハイ
ライトにより適切な補間を行います。

https://www.harrisgeospatial.com/docs/BackgroundStretchTypes.html
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DATA MANGER の機能

アイコン 機能

データファイルを開く機能です。本機能はメニューのOpen と同じ機
能です。

データマネージャの全てのファイルのバンド情報を一括表示(+)/非表
示(-)を行う機能です。

選択したファイルを閉じる機能です。

データマネージャにあるファイルを一括で閉じる機能です。

ピン/アンピンの機能は、ファイルを画面へと表示した際に、データマ
ネージャを閉じるか表示しておくかを設定する機能です。

選択したファイルをArcMap へ読み込みます。
※ArcGIS のライセンスが必要です
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